[‘maBa 6

Ucnonb30BaHue
MMMNOPTUPOBAHHOM rpadukun

A yoTé 38aa4 A0 OcTadcd, Gaéed OTOTA00 TTeTT 1TTA0edTaa0l & Flash MX 2004 &
836 yoT adeaol. Tad+eoail ToaTadacTatiaaol dafiodTadl 40ad0eés a adéoTdTop, dacadeyol
& 04aaé0edTaa0l dafodTala ecTadaeadiey, a 0aéxa cagaadacl TadaTaoda fieacey e &a+afo-
e S o o 2

TTo0edTaal 100 dafiodTald ecTadaxaies.

MmnopTtupoBaHue rpadpmnyeckux nsoopaxeHum

Agy fiTcaarey aOATeTess '3TAE0TA, TOAA+A 0BAATAATEYT ca-
a8, caanoop y efTTe 4 ETOT
T e6e aamd TAAT
fTcaarep a3eoi
Flash-6&&i1Ta TT
®aTeys. TTyoTi6
e

100 daci (o d0a

NMoapepxuBaemslie rpadpuyeckue popmartbl

A 034é. 6.1 fiTa&deeofiy ATEATE Afdd OTOTaoTa, ETOTONA TTCATEYA0 &1 TTA0edTaddl
Flash MX 2004. ATélize Ti0aT &¢ Te0 TdeéTeaTed Flash ATTATATT €1 TTA0eATAA00 fal T-
AOTY0AGUTT, TATAET 46y €11 TA0a TAETOTANO0 OTATA0TA TATAGTAEN T, ~0TAl Ta éTiTip-
0483 aGéa 6noaTTagara ToTadal 1a QuickTime 4 (ééé 4Tédd TTaay aa adoney).
E171T3085Ta300 & Flash 30a0&+4feTA &cTadazeaied TTelT TaféTeléeie Al
fi TTITAlp éTiafa Import to Stage (ETTTA0&TAA00 Ta dAEAT+44 TTE
(ET1TT0085TA200 & 46A8eT0480) ec TTATATP Import (E1TT0), fi
File (Daéé); TA0TATT &TTedTaarey & Afoadée +404c 40040 TATATA; BGAT 1
AOTTE N GAAT-AAT TTEY &8e &¢ ACAEeTOAGE AAGOATAT 4TE01AaT0a Flash. Te
daci 40 Oaésa, TOTONE T1TeiT @1 TTA0e8Taa0l 4 Flash, ATH0AA8YA0 2x2 Teéhdsy. EST
OTAT, Flash ATTATATA SaATTcTaol TTNEAATAA0AEUTTOU &cTAdaxdTeé & e’ )
iiT.

i
afnp a4 TaiTadaia



Tabnuua 6.1. UMnopTupyemsblie rpadmyeckue chopmatbl

Tun danna PacwmpeHue Windows Macintosh
Adobe lllustrator .ai,.eps,.pdf X X
AutoCAD DXF - dxf X X
Bitmap .bnp,.dib X x(c QT 4)
Enhanced Metafile . enf X

Flash Player .swf, . spl X X
FreeHand .fh7,.fh8,.fh9, X X

.fh10,.fhl1

GIF unu aHummpoBaHHbIn GIF .gif X X
JPEG -ipg X X
MacPaint .pntg X (c QT 4) X (c QT 4)
PICT .pct,.pic x (c QT 4) X
PNG - png X X
Photoshop . psd x(c QT 4) x (c QT 4)
M3o6paxenne QuickTime .qtif x (c QT 4) x (c QT 4)
Mao6paxenue Silicon Graphics - Sgi x (c QT 4) x (c QT 4)
TGA .tga x (c QT 4) x (c QT 4)
TIFF tif owm L tiff x (c QT 4) x(c QT 4)
Windows Metafile - wnf X X

QT 4 o3Ha4vaeT QuickTime 4

MmnopTupoBaHmne pacTpoBbIX U300paKeHnn

CarTiTéod, +0T, TacadenelT To ATTATAa eTTTo0edTaaiey, BafodTaTa ecTadaxaied
anadaa nTodaTyaofy a 4eaeeTodéd aTeoTar

©A46&T04GE 4TE0TAaT0a Flash. TTyoTio éTiataa File=Import=

a
0 dafodTadp d6adeéd éaé TATTNOAAM0AATTIT Ta BadT+ad TTed aT-
A b

Import to Stage TT14af0
éoiaioa Flash, 0aé e a
46466T0460.
Oaéei Tadag
Teol nedaopuidd

©46eT0aé0, a éTiafaa File2Import=>Import to Library — 0TEUET &

11, 38y e11To0edTaaTey BanodTATAT ecTadaeaiey 1.

1. T08ATE0a 4Té0TAaT0 Flash, & 6T0To0é ITAEBaA0aNl TTTAaN0eol eécTadaraied, eee
fiTcaaéod TTacé . fl a-6aée

2. Aneeé 0Toe0d fdacd T TTA0EATAA0I ecTadaeaTed Ta AaAT+44 TTEA 4Tée614To0a, al-
440604 eEp+aaTé €aad A ToeiTi NETA, €043 a0 fiTaedadddni aaT WTianoeol, &
adTTereod ériaras File=Import=>Import to Stage. Ta yédaia TTyaeony rTéacai i1a
Ta 8éfi. 6.1 4€a&TATATA TETT Import (ET1TT80).
Ange 6Toe0d eT1TTH0eATAA0I ecTadamaTed OTEUET 4 4e48e
d&0a é¢ Taip éTiaiad File=Import=>Import to Library. ToéaTaony aéa

(E17TTO0 4 4848€T08€0), ETOTATA ToEe+adofy
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TTO0EATAAT €3é dafod

Manka: I@ b 01 fOKRYMEHTE! j - ﬁ -

Security
MoK PHEYHEH
BADSCAMZ, PG

Wrma daiina ILEaf JFG j Otrpeme I
1 Tun saiinoe: IJPEG Image [*.ipal j OrrgHa /l
7

Puc. 6.1. Buibepute ¢ NOMOLLbIO 3TOro AManoroBoro okHa dann (unm
barinbl), KOTOPLIN XenaeTe MMNOPTUPOBaTb

Té3 6aéeTa, Toe+al a
firéiéa Tun caiinos (Files of
eéeé All Formats (Afd 6T81a-
aceaoTé éeadewd <Ctrl> (a&y
fiedaTaaodeuiTioe, a caodl fa
a é1TTéd OTkpbiTh (Open). Oa-

Teadnoda OaééTa a aeaeeT-

®TTHOU0 TATAATTT TTéacia 1oe el

Flashix =
® Flash doesn't recagnize the file Format of 'Ball.psd', Would vou like to try import via QuickTime?
Aa I Het |

Puc. 6.2. 3710 coobLueHne oToBpakaeTcs Mpu KaXaoM UMMOPTK-
poBaHuM haiina B dopmate, TpebyoLeM HanMyms NporpamMMel

QuickTime
A&y TAETOTONO OTOTa0Ta, Tardeidd PNG TaTadaiia Fireworks; EPS, PDF, Al
T8Ta8aT 10 lllustrator, a 0aéxd 46y OaééTa T8TAda1 10 FreeHand, ToTadageony atia TaiT
4CAETATATA TETT 48y cadarey aTTTéTe0déiTao TadaTaodTa e111o0a, TTcaTeypuied it-
afeol 6aaaé Gaé C 080 & 0.4 WTAOTATAA TA @1 TTH0A Alwddéa-
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04 Tacaatey, Toeé+apCieany oTeuéT 1T-
7215140 | mage0l. j pg, | mage02. j pg,

A ACAETATATI Téia Import TAeT Oaée
OtkpbiTe (Open), Flash ToTadaceo
63303 €T TTA0e8TAA00 fidacd afp
& Oa (Yes), afiée ®& 102iT €1-

a

)

(Yes), Flash TT1
€aa6a) a 0aéoCIAT fieTa.
ATTTéT0860T0A eep+aa0a eaasq.

Foshtx x

® This file appears to be part of a sequence of images. Do vou want to import all of the images in the sequence?

Aa I Het | OTMEHS |

)

- Q»
oo

Puc. 6.3. Korga Bbl umnopTupyete Ha paboyee none AOKYMEHTa OAVH
darin u3 nocnegoBaTenbHOCTU nM306paxenHun, Flash pacnosHaet aTty no-
crnepoBaTenbHOCTb U MO3BOMSET UMMNOPTMPOBAaTh cpa3sy Bce dannbl no-
crnegoBaTenbHOCTU

MMmnopTupoBaHmne BEKTOPHbIX N300paxeHum

Toe eirTooesTaaree A360TOTTAT ecTadazeaiey i
Import to Stage, TiT TTi1a0aaoly Ta 8aaT+33 TTéd aTéd
yeaATaToTa, fi 6TOTO0TE TTeiT SaaToaol 0aé x4, €aé & AT
e, ATcadiThie & Flash. TAETOTONA O6TATa00 TTCATEYPC
Flash 08080680 fi€Taa eeepnodacee, eT1TTd0ed0y 0 EEAaT &3
0a Flash, éeaT éaé éep+aata éaasn, a cagenéiTioe 1o
ETiai4a File=2Import=>Import to Library iT63aiya0 a

0464 4TE0TAaT0a Gaé 40aBe+anéeé NeTaTe, yecadireyd
(100l Ta 8aaT+88 1TTed T TA0TATAA T dacee+T100 0e7Tad nei
ad 6¢iadod e agaad 10.

Ange a0 Ta0ATTHe04 4360TOTOA defioTée a Flash TA0TATH 6TrédTaaiey a 46040 Ta-
Ta7a e TTiedaopridé ancaaée a 4Tédiaro i TTiTuilp &Tiafad Edit=>Paste in Center
(Toaaéa=>ArR0aaéol 4 6aT0d) ééé Edit>Paste in Place (Td3déa=>Ar0aaeol Ta 1aA0T), OT
Tié TTyagypony 1a 6aaT+ai 1TTeéd 4 4é4d fa80TTedTaar 106 0ea0d, éaé é a ned+aad en-
TTélgTaarey éTiarad Import to Stage. OT &8 TOTEAOTaE0 & To& Taddoaneeaaree aje-
0TOTTE d0a0eée é¢ TéTa 4604Té ToTadaT 10 4 4Té61aio Flash.

Pa6oTa ¢ popmaTtamu, NO3BONSIOLLUMMN COXPAHUTb
CTPYKTYpPY C/OEB
0aéed ToeéTearey, édé Macromedia FreeHand, Fireworks & Adobe Illustrator, TO8aTf-
5i .

fiTodaTeol endTarop fod6e06d0 feTaa, B3aacoess6atté 0aéno
: & 4 eTTTO0EB0ATTE eeepiiodacee, +0T TTCATEYA0 €A4ET
PO o 5 fia

a
Flash. T TeelT 0388 &1 TTO085TA0U Afid eA6TATO
a

ETE
Tada-

Q» gl)o (02 T

N ~a AQANAX =Ll NXMNAXNAZ -

Flash eéé 8afioadecTaaol adéoTdidp a8a0eéd (1
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®

UmnopTtuposaHue .png-dainos nporpammbl Macromedia Fireworks

2~ ~ 29 - =2

NTc434341 04 & voT40a1 14 Macromedia Fireworks . png-6aééa i
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, NéTe, 1ardaa-
éypliéd & aaxd €aadn. Ide eiTTooedTaaree 0aéed OaééTa a Flash, 1TelT 6éacaol,
dTéxiTa ée éeepnodacey TTi1avaoliy a 4TE0TaT0 éaé aaeiTa AanodTATA ecTadaxadied
Taua
TTiied A04aToa 4 ACAETATATT Téfa Import @éé Import to Library fiTcaai iTaT 4 Fireworks
. png-0aééa & tdé+éa Ta éiTréd OtkpbiTb (Open) Ta yédara TOTABACEONy ASAET:

TéiT Fireworks PNG Import Settings (TafodTéée ei1Toda oTdTadd PNG T1oTadal
Fireworks), TTéacai iTa Ta defl. 6.4.

Fireworks PNG Import Settings 5'

File Structure: © Impart as movie clip and retain layers

ia
\\\\\\\\\\\\\ 403800,
T

" Import into new layer in curent scene

Objects:  Rasterize if necessary to maintain appearance
' Keep 4ll paths editable

Test: © Rasterize if necessary to maintain appearance

' Keep all text editable

[ Import as a single flattened bitmap

Cancel

Puc. 6.4. Onuum 3TOro AMarioroBoro OkHa
No3BONSIOT Yyka3aTb npunoxeHuo Flash,
KaK MHTepnpeTMpoBaTb UHGOPMaLMIO CO3-
JaHHoro B nporpamme Fireworks . png-

anna
A 4838TATATT Téia Fireworks PNG Import Settings €1 &30y 08& 480TT0 Tad&éép+aca-
gaé & OeaxTé Import as a single flattened bitmap (ET1TT60&6TAa0U €3é Taudaefaiita a
846 TTA OAETA BANOOTATA &CTAdARATEY).

[
3

port as movie clip and retain layers (E17TT80&5TAa00 &3é deaiTeeer
08680080 NETAA) €T TTO0E30A0 . png-Oaée éaé acadTeéeT.
€aadl e fieTe . png-Oaééa ATodaTypony aroode fi

0203 €1 TTA0a 4 464E€T0AéA 4TEOTAT0a NT¢aadony Taréa
i
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) TT1a0add PNG-é¢Tadaxd

mport to Stage) a Taet 11
6 fi

0863 feTaa. And ensTarad ne
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W Rasterize if necessary to maintain appearance (¥ 8aTadactada
120, dnée yoT 08340a0fy ey AT < :
a Fireworks cageaée, gooede e
1TT4440224350 4 4460TOTTE OTO14. ATagie
foup ATGdATYAONY.

B Keep all paths editable (Ti

0aée
@171Td04 A Flash 43é0ToT6p TEedT
e

[EYEED
00, éToTo04 F

e yoo
6038y 0.

0a Fireworks.

Tadaeep-acaee ad6TTO Text (O46f0) 6T52a8Ypo ST TTSOTT 04é
B Rasterize if necessary to maintain appearance (18aTadacTatiaaol a danodtaté oT1o-
130, anee yoT 003acaociy aey nTodatatey ATAoTAAT AeAa) casado danocadécadcep
04éfioa, aneé TT ATcaal & Fireworks fi efTTelcTAATEAT TaITaAAd0x2eaadT 00 ToT-

B Keep all text editable (Tfi0aaeol A4fl 0470 6442608041 0T) ATOAATYA0 A4fl 04éfd
Fireworks 8343608804101 TThe& €17TTd0a 4 Flash. TATaeT TAETOTANA 04enoTand
yo604aéot Fireworks TT460 400U 6048y Ta

Toe 6foaiTaéd Héaxeéa Import as a single flattened bitmap (E17TT0023Taa00 éaé Tau-

d4eTATTTa 4 448174 GAETA BaN0BTATA e¢Tadaxaied) ana ThoaeliTaa Troée foaiTayony

TaaTiooTTaT e, TTRETEUEO TT ¢adaddo eiwTd0 . png-Oaééa Ta aéoeainé feTé eée a

4048€T04G0 A A4eAA A4S TTAT DANOOTATAT ecTadamaTey. ANd 4480TATOA yedTaTod & 04éfod

ELE AcT: danod, ~0T éé@eo aan aTciTeiTioe 53aaéoedTaaocl ed a Flash
i

atieé 3380TAT0A 683680 & 8aaaéoed

1410 Flash dafoddecTaar iTa ecTada

)

Qo
-
(04

addoaneeaairee e

fiedadptidé ancaaée (0aé =i 6aé & T
10 Fireworks & 4Té€014a10 Flash) ana aae
8 TATA are

fieéon & 44 T1Ta Ban0dTaTA egTadaz
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aéaxd fiodareod é fie

e a Flash 6aééta ToT:
0 1
a. Oaéed pedTees a

9 = A A

. Adxd ecTadaxaiey, AOTTETATIOA &
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TO04 & aTé0T14aT0 Flash 46460

6adee+e0 daciad Oaéea.

[ | 1644 8 04a0Ta a
a, eiTTéucraair’t
At iTa 4 FreeHand 38aa
TTo0EdTAATES TOTAdAT Flash a64ao
(clip paths) &4éy éToadrdacacee yo
0a, 00801 Tadacée, 1T fdoe, THAAM0aaeypo TaTé ddade-
fiéed néTaTed ATATEUTT NeTeTTé 080800801 & 6adée+eaapo daciad Oaééa. xoTad
TeiéiecedTaaol daciad Oaéea, iTcaadaéoa a FreeHand 48a4€aT0T0A caTTETaATEY
fi @ATTEICTAATEAT Ta 4TE&d 8 0AA0TA eée caTaredd T TTo0edTAATl 114 40348410
TTA cATTETATEA 3024€ATOTOT cATTETATEAT, ATCAATTAT A Flash.

B A380TOTOA 4 4e44 Tad&0Taa TO T @3000 é 4004Té, TTEe6+aTi104 a
FreeHand fi - g), 0aéxd 0adce+eaapo 8acTad
Flash-6aééa, 7 3040 eamané @aid yoTaT Ta-
8a0Taa €aé Toa (o)

B E3330a0T04 TeTi+arey o0d0edTa FreeHand T8& @1TT804 a4 Flash 46400 ToaTada-
cTAATO & TEB6AE0A TETT+aTey

m Afee 7a a t Téfa Preferences (TanodTéée)

TOTA0aT 10 FreeHand 1a 6ficaiTacdi Oéa=Té Troeé Convert editable EPS when
imported (T 04TadacTa04a0U 3442808041 0é EPS Tdé @1 71Ta0d), 0T 4T440yai 04 a
AAAA S T4 40400 ToTadaseaouny rée TThHedadp-

CIAT @1 TTO04 YOTAT aTé01ai0a 4 TdTada1 10 Flash
440308 4 ACAETATATI TETA Import ééé Import to Library 63aéé voT-
fieéé TOTAdaT 1 0) & CIdééia-
éiT FreeHand Import

4GAETATATI Teria,

FreeHand Import x|

— Mapping
aK I
Pages: % Scenes
" Keyframes Cancel

Layers: (% Layers

" Keyirames
" Flatten

~ Pages
& 4l

" From: I Tm'l

— Options
I Include Invisible Layers

¥ Include Background Laper
¥ Maintain Text Blocks Help |

Puc. 6.5. [JuanoroBoe okHO Free-
Hand Import nossonseTr 3agatb
onuuuM MMnopTa Ans COo3daHHOW B
nporpamme FreeHand BekTopHOWN
unncTpaumm

A 4567v4 Mapping (Wo&TA0acTAATEd) eTAadofy &da Ta

(Nodaiesn) & Layers (NéTe).
Tadaéep+a03ée TaaTda Pages 0T83a6YPp0o @TTTOOTT fodaTes 4Té0TaToa FreeHand.

T0a Tadaéep+acdedé Pages
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I | aie T
édiaifoa FreeHand ToaTadacoaony a éep+aaTé éaad aTédiaioa Flash.

Tadaéep+acdee TaaTda Layers 0Td3aéypo €1 TTOOTT NETAA 4T€014a10a FreeHand.

m A Té 4Té01a10a FreeHand

048004 Tadacep+acdél Layers (N&Te), +oTal éaxané fie
06 1

a0eé ToaTadacTaal a neTé aTéoianoca Flash.
[ ] ealé NeTé artéoiaioa FreeHand a0é TdaTadacTaar a éép-
@aad areoiaioa Flash, 40448€04 Tadaéep+aodel Keyframes (Eép+adda
| ép+a0&éy Flatten (TaudaeTeéol) afad féTe aTé61aioa FreeHand
HEAA0 5 a1 feTé aTédianoa Flash.
Y8ATA4T00 0TdaaeaTey 400110 Pages TTCATEYPO caaaol @1 TTA0 andd eée OTeleT TT-
8348641100 fodaTes aTéeoiaioa FreeHand.

01T €T TTO0SOTAA0U afa fodaTesl atéoiaroa FreeHand, 401448&04 Tada-

B Ange To=iT @1TTO0eATAA0 OTEUET TIO3A46ATTOE A4RATACTT NOdaTed 4ATe014T0a
FreeHand, 40438€08 Tadaé&p+a0deiu From & 4334e04 & daiTTETeaT iTa ATAA4A TO
TA4T TTEA TT1a0 Ta+aeliTé nodareod aéaragTia, a 4 W7Téd To — 1T1add éTia+-

1Té fiddaresn aeavacria.

T
[
(02
(a2}
O
D:
Q.
8
[
m)

A 336714 Options (T28a14080) THA4M0AAEATO 08e fiedas
]

OeaxTeé Include Invisible Layers (Aéép+eoli Taaeaed 0a neTe) 6éacnaado Flash ei-
TTO0E8TAA0U Afd NETE 4TE0T1aT0a FreeHand (éaé aeaeida, 0aé é iédaoaa).

m OfodaiTagdiiaé 1T oiTé+aiép 68axTé Include Background Layer (Aéép=+édi
OTiTalé NeTé) 0éaciaadd Flash e1TTd0edTaaol OTITalé NETé &aTési1ainoca
FreeHand.

m OtaxTé Maintain Text Blocks (T Ta44dxea300 046NOTANA A8TEe) Of0ATTAGAT 7T
oiTé-aiep & caaado fiTodaTared 0défoa FreeHand éaé 83&aéoedoaiTaT 0aéfioa a

4TE614104 Flash.

UmnopTtuposaHue ¢aiinos nporpammsl Adobe lllustrator

A aTe61aT10acee @ Flash MX 2004 6éac0aadofy, +0T Tia 1Tedd
fi

(04
ox
o
(0]
ox
=)
a»
m;
o
c:
.
1

6aéen ToTadaT 1 G Adobe lllustrator Ta+éfay i @afioTé aadnee, . eps-Oaéel anad aas-
fieéé, & 0aéxd Hacet O6TAT1a0a PDF addnee 1.4 eéée 41644 datiaé.

T2 10280864 A0ET 6f0ATTABATT, 0T Flash MX 2004 TT¢aTéyad @1 TTo0edTaddl . ai
TATTO4 03828 & 4 4ATédd daTied aadneyd, +a41 Adobe lllustrator 6. Taia

anee yoé 0aéel nTaddead ATaadail
y. E6T1A O0TAT, 1T6& eiTTo0edTaareée . ai -Oaéea aadinee 9.0 ToTadaseadony aéa-

&TATATA TETT Import Options (Wadaiaod0 €1 1TH0a), TTEAcATTTA T4 déf. 6.6, a 46y ATEad
€ — 4eaéTaTara TéiT llustrator Import (8efi. 6.7),

Flash MX. Tée ei1Td0edTaaree 6aééTa a oTo1a0ad

10Tadaxeadony aeagTatata TeéiT Import Options.

>
) 1
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Import Options

—Convert pages ko
1 Scenes

x|
||
' Keyframes Cancel
v |

—Convert layersto ——————————————————— Help

' Layers
" Keyframes
© Flatten

—which pages to import:
& al

A s |1
€ rom: | @ | =
~aptions: G
¥ Include invisible layers Layers @ Layers ol
- © Key Frames

¥ Maintain text blocks = i

e
[~ Rasterize ewverything R s
|72 'I Rasterization resolution Optors

¥ Include Invisible Layers

Puc. 6.6. [OQuanoroBoe okHO Import Options Puc. 6.7. Quanorosoe okHo lllustrator Import
nosBonsieT 3agaTb onuuv nMnopTa Ans . ai - CNYXUT ONs yrnpaefieHnst MMMopToOM . ai -
darinos Bepcumn 9.0 (M HOBee), a Takke . eps- arinoe bonee paHHux Bepcui, Yem 9.0

n . pdf -cpainos

ATeize o
10 TToey1 a
83. A4 ThRoaaTiT

Import Options, ataérae~+-
70 4 T83a0400IaT Bagaa-

Layer ¢&dil T8&60M0a0a

a 0T0&04 Tde
Flash T83T4dacTaaou afp eéépnodacep a
PN T .

0aiTaée OEa=xéa Rasterize everything

fiéTé &) 40400 TAATHOOTTO (0aé éaé afa NeTe TaudaeTypoiy a Taer), a & TTéd il
fiéTT1 Rasterization resolution T TeeTT 40430 casaol ¢ia+aTed dacdawaiey, ETOTOT:
enTTelcTAd0URY Toe dancddecadee. T TeiT Addfoe ATAMCAATITA ciazafed eee an
éc danédtaapuiaaTiy fiveféa TalT é¢ foaraasoTad

al
(YyoTO TOTOAMNN 0aéed Tachiaapo Odan

4T04 N TOTNOTE BAfOSTATE 3dad

cTadaxaiey 4 a3éoToiTa
fa - ITédcia T8¢ da-

Qo

§ 58S

)

: - Q)
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T4 caa01aaéod, +oT TTNed 002 0a aaeé a0+-Taié d4éoToTaie Hedvdaie
u é .. o N i 3BOSBTAAT

Flash, daiTTéTee & daaaéoedtaaree —
Tad3édtaapiesn a Taéeaataapuéany
caceadée eear neeaapony a caT1afyao ATané
Ta0368013331 0é 6+anoT fiéactiaadony a 46aaa 4
A&y 0TAT +0TAO 08affiedTaaol aopuidd
1. ETTT80880€08 Aaf0dTAT: 704 Flash. (Anee
TIT 02d 40ET €1 TT00€5TA deaeeTodée 1a
daaT+ad TTea a i1
2. T4 To14Tyy anadearey y " 5 Modify=>Bitmap=>
Trace Bitmap (E¢iaieou=>Dafc a0l BafodTATa ecT-
ddaxaied).
ToedTa0Ny TTeacaTiTa Ta defi. 6.8 &éa T Trace Bitmap (Odafifiedtaéa
BanodTATAT e¢Tadaxdiey), 4 éTOTOTT T 1T cadadl Tada1a0d0 odaiiesTaée.

Color threshold: | 1Y
Minimum area: l— pixels Cancel
Curye fik: IT\ght 'I
Corner threshold: INormaI 'l

H
e
Ix

Puc. 6.8. inanoroBoe okHo Trace Bitmap
Nno3BONsieT 3adaTb nNapameTpbl Npeobpa-
30BaHUsi pacTpOBOro U3obpaxeHns B BEK-
TOPHOE, KOTOpble OMPeAensitoT BHELUHWUI
BMA pesynbTaTta u pa3mep danna

Ta+47€4 Tada1a0da Color threshold (N T8Ta oaaoa) a aearactia 10 1 &t 500.

a1aod o1 6aaeyao ETEe+aMoaTT 6440
TOHTOANNA 08annesTaée BaNOSTATAT €¢Tads

A N QN N -

cia-aiféé RGB-0adoa iiThaares reénagaé it
74084 Color threshold. Afiee daciesa TaTiad,
fi+€0ado0 ﬁy, —0| Téecddapuied reénaee eiapo
ad+efgarey, ToTadal 1a Flash 6fidadaiyao 6adoa.
+arey |a6a|a06a Color threshold iTT04301104630
TéTi—aoaem T aae0|6| T eglaéaaeél'éé

9 ~x 9

f1aT014r1 1 000. Yot gla—alea |6aa aééyéc‘)

A~ 0 Noas A~ M

YOT0 TadAT 400 ca&addo, TaRETEleT Aasasear
651 3éyao neTee TTNOU 6a90euoe60|oué6 éveand
g ’6aaea|e|o I T elaao zanou arci |ae|u6 9|"+

Very Tlght Tight, Normal, Smooth & Very Smooth
6. AD4ddeo0d cia+aTed ec 8anédnaapUIdaThY fréféa Corner threshold (TTOTA 6483).
5 oad A oy

YOTO Tadaia0d 0TdAAEYA0 TADAATOETE Thod(

goaféol Thodta 6den 6ed0d 4 ecradaxaiee,
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@4 Few Corners (T aéT
0T+1Ta ¢fa+afed Normal.

e}

aT foTanoaa ateT TTéo+
Color threshold (25) € Minimum area
ixels, a &y Corner threshold — Many

Corners. A a aé ecTadaxaied firdada ateT TTeo-
1T fi efrTél cia+aféé TadaiaodTa Color threshold (100) &
Minimum area (25), 4éy Tadaiaoda Curve fit A0ET cadaiT ¢Ta+dTéd Very Smooth, a aéy

Corner threshold — Few Corners.

Puc. 6.9. NcxogHoe pacTpoBoe n3obpaxeHue (creea) U pe3ynbTaTbl ero TPacCUpOBKU C
pasHbIMK NapameTpamu

Pa3peneHune u pepakTtuposaHue pacTpPoOBbIX
n3oOpaxxeHnin

N Y

Dacadeeoi) TTelT dacadeeol

5poE

.

a+afodd cagedée aey fiTcaadadl

Q> St O/ N mmy Q>

o™
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N3meHeHne pasaenieHHbIX pacTPOBbIX U300paXKeHnn

x0Ta0 6Gaé-Teadal eciareol Taganol dacadear
T0e1T fiTa+aca a04déeol. Agy yoTaT Aa0TTéTe0a fiedadpuda.
1. Anéé 5anodTaTa ecTadazaTed AtIA T4 JAcAABATT, A0A36804 4T Ta GAAT-AT TTéd é
aorTéireoca éTiafad Modify=>Break Apart ééé Taxiéod éTideiadép ééadeo
<Ctrl+B>.

N
>
D
O
o
Q.
[0
Q)
D
QX
o
PON
o
Do
D
-\
=
O
x
o

U TAiTatT O

X
O
> Q)
\ O
an
o
Q:
QO
[0
[0
(o]
=

(TOp Taeanou ecTadazaiey, efrTeicoéod eino-
ééé dax=e14a Polygon Mode (Dazeéi 1 TTATOATEN-

u-

166a), éaé a TTAOTATT TréfaiT 4 46aaa 4.)
5. UJ&eéireod ia éiTréd Magic Wand Properties (NaTénoaa ATéodaiTé TasT-ée),
+0TAO ca&daol TadaTdodsh, Trddadeyplied 8acoeicad anadeditey ernodoTatoTi

=07
Lasso 4 d4xeid Magic Wand. ToédTaofy A€a&TATATA TETT Magic Wand Settings

1Té TaéTr+ée), TTéacaiita 1a defi. 6.10.

T
Threshold: Iﬁ Ok I

Smoothing: INnrmaI hd Cancel |

Puc. 6.10. [lnanoroBoe okHo Magic
Wand Settings

o =

o
ox
-/
Qo
o
x
m»
(9]
3

o

o

=
=y
>

7. Caaaéod cia+aied a
édtaapudiiny i
éél’l’Oé a TToyaéa arcdan
(A864Ta), Normal (Ta0+1T4
; 0 K, 0Ta0 Toeiareol ciataifey radaiaodra e caédqoi
and Settings.
Ti OafodTATE ec¢radamadiee, =0
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PepakTupoBaHue pacTpoBbiX N300paXxeHui

TayiT &c N6&A0 Flash TTeTT cATORGA0H 4004

ITelT 1aéo

m~p 2 O = = Q

TOeET2ATE4, 6i0aTTacaT1Ta Ta 4AQ

F
aedfeeé.

Qx

HacTtponka cBOMCTB UMNOPTUPOBAHHOIO
pacTpoBOro n3oopaxeHus

a Library T0ee1Ta €¢Tadaeaied & (1aééieod 1a é1Tréa Properties &

cé&a lela.
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Bitmap Properties 5[

I Leaf.png Ok, I
GilDocuments and |
SettingslAanmircTpatopiMon Canee!
S WHNA 2003 1. 3222 Update |
190 % 243 pixels at 32 bits per pixel

Import...
¥ Allovs smoathing —I

Compression: [Phato (JPEG) = LI

™ Use document: default quality

Quality: ISD {100=highest)

Puc. 6.11. C nomoliblo AuanoroBoro okHa Bitmap
Properties MOXHO 3agaTb napameTpbl kKayecTBa U Cxa-
TV Ana noboro MMnopTUpoBaHHOro B AOKyMeHT Flash
pacTpoBOro n3obpaxeHus

1 6380 aeaéTatarar Téia Bitmap Properties €1
1083, 488 ToTAdaxadony SanodTATA ecTadase
fanodTééaie.

Qo
b}
(04
Qo
aQ»
o
Q»
Qo
O
ju
O
Q.
(]
(¢
jun
O
Do
1

ITéd 4 4300Taé O0ATOBaelTTE +afoé ACAETATATAT Téfa TOTAGA:eadd €iy Oan0dTATAT
ecTadazeaiey a 42a8eTodéd 4Te01aioa. Aadaeod fipaa TTATA Tacaaied, &fee 6Toeod éc-
TaTe0l Ty ecTadacaiey a 4e4a6eTodéd

W74 TTEAT i TacAaredl ToeaTaeony ool AOT+T€6éa, 44T daciadh e ef-
OToTadey T 4208 e1TTo0edTaaTey ecTadaxdiey (yoé &aiiad Tofdofioadpo, anee ect-
A6aaTE4 AN0aasyeTil ¢ 406ada TaTaTa).

Texd BANTTETRATO yEATATOO 0TdaeaTey, i TTITOUPp &TOTON0 & cadapony Tada-
13080 fieaoey e éa+anoaa danodTATAT ecTadazeaiey

B OéaxTé Allow smoothing (Pacddgeol ndcaeeaared) casaado daciGiaaied, eéeé naea-

®e@3aTed, TTO0ANOTNE 40aTed a ecTadaxairee. OToy Toe yoTi ecTadamaied 1a-
AETEUET fiTactaadony, 1T ¢oa+a0Thiol ETT08af0TG0 48aTed & ecTadaeaieyod fi Tec-

B DafedtaapuIeéhy AT y) I
TTa8e 46y ficaody SaMOOTATAT ecTadamarey. A T&1 ATHO6TTO 44a cTa+afey Photo
(JPEG) (OTOT (JPEG)) & Lossless (PNG/GIF) (Ad¢ TT0ad1 (PNG/GIF)). Tadaiod

Compression (ET\IATBQﬁﬁéY) "TCATEYA0 casadaocu onoa-
1 arnooerit

110
Photo (JPEG) TTadTaeo aey T+aTl féTeTO0 8afiodTa00 ecTadaxaiéé (Tardeias,
OT0Ta0a0eé); cadapliéé fieaoed dac TTOAdU Tada1aod Lossless (PNG/GIF) dTélioa
TTa0Tae0 aey 8anodTatd egradaxdied, ATAOTYCIEd e¢ TATHOO0 6eddd & fiTaddea-

ENIEN AN AN i s s~ 2i A QNN

Ci1ed 4Téluwed o+afivée TATTOTATTAT 04doa.

TTyaéyaony, étdaa a dafédtaapudiny Arenéa Compression a0adal Tadaiaod
Photo (JPEG). A&y T TT80e5Taai 100 ecTadaxdieé a 6181208 JPEG T

iy Troey Use imported JPEG data. YO0TO O&azTé 6fidaiTagat 1T oiTeraiep, 0T
TTadaco134a30 enTTelcTaared endTaiTar éa+anocaa e1rTooedtaait ecTadazea-
Téy & TTcATeya0 ecadeadi TTAOTOTTAT JPEG-feacey. Agy écTadaxdieé a 460380
OTOT1a0a8 TTYaeony Troey Use document default quality. ET44a yoTo O&azTé 6fida-
1Ta6aT, é écTadaxadiep TéeTaiypory a6TaaélT0a oOfcaiTaée éa+ancda JPEG-
fieaoey, cadadadiGa aéy 0a80UIaaT aTéd1ai0a 4 46aéTaTari Téia Publish Settings.
=x0Tal cadaol TTadp 6ficaiTaéd JPEG-fieacey aey ecradaxdiey, 10eiT NadTheol
66axTé Use imported JPEG data €éé Use document default quality & aaanoé TTaTa

Q =9

cTa+AT@4 (A 48aTacTia TO 1 4T 100) 4 TTyaeawaadny TTéd Quality (Ea+afoaT). YoT
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T1 TEé1a Publish Settings, 14

J i
TaaT 108 JPEG-écTadaziiey. Aey 16 Tadai&aodl fieaoey cagapory
a aeaérara

-\ (D: :Sf |'|'|) - Qo 83
<t (':Dl Do
" \(D’ -\
D

>

J2 S

= S

o =

S 3

)

—; - o QJZA

Pe3iome

0+1Té &éy aa
00 Flash 6T«
0 Flash T6&1T 1T-
fiodacep, fiTaas-
80+28 TORTAT

h dafodTaTa e

) a0adediey Taeanodeé, carte

ATarTai 0A30Ti éée 4
oedtaaiey A TTITUlp add6aed e

TO0&ATETA, € TTNEaadp IdaT
f0d0T1aT0Ta T8TadaT 10 Flash.
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S s AN o~ Q-

fi0AWAT U Neaoey

]

)

=-) D\
2

) @
13
o
Do
-/

. @
-
Q.
o
a»
Y

! ©
o
g_))
:
c

“©
g_))
Q.
Q.

CaTEyao 4Taéo

o

" -,

éia Bitmap Properties 48y éazal
imported JPEG data.

1. Eaé e1TTo0edTaa0l ecTadaeaied a 4Té01410 Flash, T4 TT1a0ay 83T Tde yoTi 1a

Q = =~

ATiITaT 1a daa
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